
CONCURSO PÚBLICO

32. PROVA OBJETIVA

ANALISTA DE TECNOLOGIA DA INFORMAÇÃO (DESIGNER GRÁFICO)

� VOCÊ RECEBEU SUA FOLHA DE RESPOSTAS E ESTE CADERNO CONTENDO 50 QUESTÕES OBJETIVAS.

� PREENCHA COM SEU NOME E NÚMERO DE INSCRIÇÃO OS ESPAÇOS RESERVADOS NA CAPA DESTE CADERNO.

� LEIA CUIDADOSAMENTE AS QUESTÕES E ESCOLHA A RESPOSTA QUE VOCÊ CONSIDERA CORRETA.

� RESPONDA A TODAS AS QUESTÕES.

� MARQUE, NA FOLHA INTERMEDIÁRIA DE RESPOSTAS, QUE SE ENCONTRA NO VERSO DESTA PÁGINA, A LETRA CORRESPONDENTE À ALTERNATIVA 
QUE VOCÊ ESCOLHEU.

� TRANSCREVA PARA A FOLHA DE RESPOSTAS, COM CANETA DE TINTA AZUL OU PRETA, TODAS AS RESPOSTAS ANOTADAS NA FOLHA INTERME-
DIÁRIA DE RESPOSTAS.

� A DURAÇÃO DA PROVA É DE 3 HORAS.

� A SAÍDA DO CANDIDATO DO PRÉDIO SERÁ PERMITIDA APÓS TRANSCORRIDA A METADE DO TEMPO DE DURAÇÃO DA PROVA OBJETIVA.

� AO SAIR, VOCÊ ENTREGARÁ AO FISCAL A FOLHA DE RESPOSTAS E ESTE CADERNO DE QUESTÕES, PODENDO DESTACAR ESTA CAPA PARA 
FUTURA CONFERÊNCIA COM O GABARITO A SER DIVULGADO.

AGUARDE A ORDEM DO FISCAL PARA ABRIR ESTE CADERNO DE QUESTÕES.

20.12.2009
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FOLHA INTERMEDIÁRIA DE RESPOSTAS

QUESTÃO
RESPOSTA

01

02

03

04

05

A B C D E

A B C D E

A B C D E

A B C D E

A B C D E

06

07

08

09

10

A B C D E

A B C D E

A B C D E

A B C D E

A B C D E

11

12

13

14

15

A B C D E

A B C D E

A B C D E

A B C D E

A B C D E

16

17

18

19

20

A B C D E

A B C D E

A B C D E

A B C D E

A B C D E

QUESTÃO
RESPOSTA

26

27

28

29

30

A B C D E

A B C D E

A B C D E

A B C D E

A B C D E

31

32

33

34

35

A B C D E

A B C D E

A B C D E

A B C D E

A B C D E

36

37

38

39

40

A B C D E

A B C D E

A B C D E

A B C D E

A B C D E

41

42

43

44

45

A B C D E

A B C D E

A B C D E

A B C D E

A B C D E

21

22

23

24

25

A B C D E

A B C D E

A B C D E

A B C D E

A B C D E

46

47

48

49

50

A B C D E

A B C D E

A B C D E

A B C D E

A B C D E

QUESTÃO
RESPOSTA
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LÍNGUA PORTUGUESA

Leia o texto abaixo para responder às questões de números 01 a 06.

O que distingue os milhares de anos de história do que 
consideramos os tempos modernos? A resposta transcende em 
muito o progresso da ciência, da tecnologia, do capitalismo e da 
democracia.

O passado remoto foi repleto de cientistas brilhantes, de ma-
temáticos, de inventores, de tecnólogos e de filósofos políticos. 
Centenas de anos antes do nascimento de Cristo, os céus haviam 
sido mapeados, a grande biblioteca de Alexandria fora construída 
e a geometria de Euclides era ensinada. A demanda por inovações 
tecnológicas para fins bélicos era tão insaciável quanto atualmente. 
Carvão, óleo, ferro e cobre estiveram a serviço dos seres humanos 
por milênios, e as viagens e comunicações marcaram os primórdios 
da civilização conhecida.

A ideia revolucionária que define a fronteira entre os tempos 
modernos e o passado é o domínio do risco: a noção de que o 
futuro é mais do que um capricho dos deuses e de que homens e 
mulheres não são passivos ante a natureza. Até os seres humanos 
descobrirem como transpor essa fronteira, o futuro era um espelho 
do passado ou o domínio obscuro de oráculos e adivinhos que de-
tinham o monopólio sobre o conhecimento dos eventos previstos.

(Peter L. Bernstein, Desafio aos Deuses)

01. De acordo com o texto,

(A) apesar do avanço da ciência, o futuro hoje é tão incerto 
quanto na época de Cristo.

(B) a geometria de Euclides era ensinada na biblioteca de 
Alexandria.

(C) o capitalismo e a democracia dependem do progresso da 
ciência e da tecnologia.

(D) em quase todas as épocas da história humana, há demanda 
por tecnologia bélica.

(E) o óleo e o ferro superaram o carvão e o cobre no progresso 
da tecnologia humana.

02. Segundo o texto,

(A) o mapeamento dos céus ocorreu graças aos sábios de 
Alexandria.

(B) a civilização que se conhece teve seu início nas viagens 
e comunicações.

(C) os acontecimentos futuros eram manipulados, antiga-
mente, por cientistas.

(D) homens e mulheres eram passivos, desde que começou 
a haver domínio do risco.

(E) a democracia é fruto de tecnólogos e de filósofos políticos.

03. Assinale a alternativa em que há um sinônimo de primórdio, 
com o mesmo sentido empregado no texto.

(A) princípio.

(B) primavera.

(C) primeiro.

(D) desenlace.

(E) remate.

04. Assinale a alternativa em que as vírgulas são usadas pelos 
mesmos motivos por que são utilizadas no trecho: Carvão, 
óleo, ferro e cobre estiveram a serviço dos seres humanos...

(A) Distantes da mídia, diz Lyra, muitos brasileiros criaram 
empresas rentáveis.

(B) A fruticultura, no Vale do São Francisco, atende à de-
manda internacional.

(C) Drummond surpreende pela linguagem, humor, senti-
mento de mundo.

(D) Rubem Braga, inventor da crônica moderna, cobriu a 2ª 
Guerra Mundial.

(E) Conheça o Brasil que você, felizmente, não viveu quando 
jovem.

05. Assinale a alternativa que apresenta a voz passiva da frase: 
viagens e comunicações marcaram os primórdios da civili-
zação...

(A) ... os primórdios da civilização eram marcados por via-
gens e comunicações...

(B) ... os primórdios da civilização são marcados por viagens 
e comunicações...

(C) ... os primórdios da civilização seriam marcados por 
viagens e comunicações...

(D) ... os primórdios da civilização vêm sendo marcados por 
viagens e comunicações...

(E) ...os primórdios da civilização foram marcados por via-
gens e comunicações...

06. Assinale a alternativa em que a concordância está correta, na 
modificação do trecho: O que distingue os milhares de anos 
de história...

(A) O que distingue as milhares de épocas de história...

(B) O que distingue os milhares de épocas de história...

(C) O que distingue os mil épocas na história...

(D) O que distingue a mil épocas de história...

(E) O que distingue o mil século de história...
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Leia o texto para responder às questões de números 07 a 10.

Que coreanos comam cachorros é um fato antropológico 
que não deveria causar maior surpresa nem revolta. Franceses 
deliciam-se com cavalos e rãs, chineses devoram tudo o que se 
mexe – aí inclusos escorpiões e gafanhotos – e boa parte das 
coisas que não se mexem também. Os papuas da Nova Guiné, 
até algumas décadas atrás, fartavam-se no consumo ritual dos 
miolos de familiares mortos. Só pararam porque o hábito estava 
lhes passando o kuru, uma doença neurológica grave.

Nosso consolidadíssimo costume de comer vacas configura, 
aos olhos dos hinduístas, nada menos do que deicídio.

A não ser que estejamos prontos a definir e impor um universal 
alimentar, é preciso tolerar as práticas culinárias alheias, por mais 
exóticas ou repugnantes que nos pareçam.

(Hélio Schwartsman, Folha de S.Paulo, 14.11.2009)

07. No texto, Schwartsman critica

(A) a diversidade culinária mundial.

(B) os chineses, por serem amplamente onívoros.

(C) os que criticam práticas culinárias heterodoxas.

(D) a tradição judaico-cristã ocidental.

(E) a culinária coreana, em especial.

08. Deicídio significa um ato de

(A) matar um deus.

(B) homenagear um ancestral.

(C) matar-se por amor divino.

(D) confessar-se ateu.

(E) imaginar-se vegetariano.

09. Assinale a alternativa em que um adjetivo no superlativo está 
formado como em consolidadíssimo.

(A) crudivorismo.

(B) adventício.

(C) utilitarismo.

(D) boníssimo.

(E) absentismo.

10. Assinale a alternativa em que o verbo parecer esteja empre-
gado com a mesma regência com que aparece em: ... por mais 
exóticas ou repugnantes que nos pareçam.

(A) Parecia que as novas remessas tinham atrasado.

(B) Parecia impossível que houvesse um novo apagão.

(C) Jennifer Lopez parecia estar em dia de glória.

(D) Neschling se parece muito a Karajan em temperamento.

(E) Parecia-me triste aquela garota sentada ao canto.

LÍNGUA INGLESA

Para responder às questões de números 11 a 16, leia o texto.

The Disappearing Deal
American obstacles in Copenhagen

By R.K. Pachauri

This December representatives from around the world will 
meet in Copenhagen under U.N. auspices to hammer out a new 
agreement for reducing greenhouse gas emissions and taking 
other measures to tackle climate change. The deal is expected to 
include a commitment by developed countries to pay for measures 
in developing states to adapt to the impact of climate change and 
to cut emissions, as well as providing them with easy access to 
clean technologies.

If there is a deal, that is. In recent months, the prospects that 
states will actually agree to anything in Copenhagen are starting 
to look worse and worse. Although the Obama administration 
initially raised hopes by reengaging in the negotiation process, 
the U.S Congress has since emerged as a potential spoiler. While 
the European Union has resolved to reduce emissions 20 percent 
(from 1990 levels) by 2020, and Japan’s newly elected government 
has set an even higher target of 25 percent.

All this matters because the effects of climate change are 
very real. They are also diverse, and will likely hit hardest in the 
most vulnerable and poorest regions of the world. These areas 
can expect an increase in the frequency, intensity, and duration 
of floods, droughts, heat waves, and extreme precipitation. 
Agricultural yields will decline, with some countries in Africa 
losing up to half of their farm output by 2020. Food security will 
get worse, and malnutrition and hunger will grow.

(Newsweek, october 26, 2009. Adaptado)

11. According to the text,

(A) neither Obama administration nor the U.S Congress will 
be interested in the new agreement.

(B) the Obama administration has intended to negotiate 
whereas the U.S Congress has not.

(C) there is a consensus between Obama administration and 
the U.S Congress concerning cutting emissions.

(D) both the Obama administration and the U.S Congress are 
being flexible to accept more ambitious targets.

(E) by cutting carbon emissions at the same level of Japan’s 
goal, Americans will reengage in the process.

12. The terms hammer out in – This December representatives 
from around the world will meet in Copenhagen under 
U.N. auspices to hammer out a new agreement for reducing 
greenhouse gas emissions and taking other measures to tackle 
climate change. – mean

(A) avoid.

(B) change.

(C) refuse.

(D) define.

(E) remove.
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13. According to the text, the deal includes that investments and 
the access to technology will be

(A) provided by developed countries.

(B) sponsored by developing countries.

(C) overseen by the Obama administration.

(D) in charge of the poorest African countries.

(E) afforded by the U.S Congress by 2020.

14. The term likely in – All this matters because the effects of 
climate change are very real. They are also diverse, and will 
likely hit hardest in the most vulnerable and poorest regions 
of the world. – implies

(A) denial.

(B) optimism.

(C) acceptance.

(D) contrast.

(E) propension.

15. According to the text, the agreement in Copenhagen is

(A) advancing.

(B) hindered.

(C) concluded.

(D) evolving.

(E) useless.

16. The term yields in – Agricultural yields will decline, with 
some countries in Africa losing up to half of their farm output 
by 2020. Food security will get worse, and malnutrition and 
hunger will grow. – refers to the gains through the

(A) crops.

(B) workers.

(C) droughts.

(D) government policies.

(E) new technologies.

Leia o texto para responder às questões de números 17 a 19.

3 Homemade Natural Cleaning Products

One of my earliest memories is of my mother cleaning 
with what looked to me like cooking ingredients. She would be 
listening to the radio as she poured baking soda, lemon, and 
vinegar combinations on the surfaces of our home. Magically 
these natural cleaning products kept our home clean and smelling 
fresh, without stretching an already thin household budget. Here 
are a few basic household ingredients and items you can use to 
clean your home.

Vinegar naturally cleans like an all-purpose cleaner. Mix a 
solution of 1 part water to 1 part vinegar in a new store bought 
spray bottle and you have a solution that will clean most areas of 
your home. Vinegar is a great natural cleaning product as well as 
a disinfectant and deodorizer. Always test on an inconspicuous 
area. It is safe to use on most surfaces and has the added bonus of 
being incredibly cheap. Improperly diluted vinegar is acidic and 
can eat away at tile grout. Never use vinegar on marble surfaces. 
Don’t worry about your home smelling like vinegar. The smell 
disappears when it dries.

Lemon juice is another natural substance that can be used to 
clean your home. Lemon juice can be used to dissolve soap scum 
and hard water deposits. Lemon is a great substance to clean and 
shine brass and copper. Lemon juice can be mixed with vinegar 
and or baking soda to make cleaning pastes. Cut a lemon in half 
and sprinkle baking soda on the cut section. Use the lemon to 
scrub dishes, surfaces, and stains.

Baking soda can be used to scrub surfaces in much the same 
way as commercial abrasive cleansers. Baking soda is great as a 
deodorizer. Place a box in the refrigerator and freezer to absorb 
odors. Put it anywhere you need deodorizing action. Try these three 
kitchen ingredients as natural cleaning products in your home.

(http://housekeeping.about.com/cs/environment/a/alternateclean.30.10.2009. 
Adaptado)

17. According to the text, the natural cleaning products are

(A) controversial.

(B) inconvenient.

(C) inneficient.

(D) harmful.

(E) cheaper.

18. According to the text, vinegar must be avoided

(A) as a disinfectant.

(B) because it is acidic residue.

(C) on marble surfaces.

(D) for its bad smell.

(E) when mixed with other products.
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19. The term as in – She would be listening to the radio as she 
poured baking soda, lemon, and vinegar combinations on the 
surfaces of our home. – can be correctly replaced by

(A) therefore.

(B) but.

(C) instead of.

(D) while.

(E) by.

A questão número 20 refere-se à campanha reproduzida a seguir.

(designforu.blogspot.com.30.10.2009. Adaptado)

20. The blank in – how __________ can you live? – is correctly 
filled with

(A) long

(B) far

(C) come

(D) high

(E) many

CONHECIMENTOS ESPECÍFICOS

21. No processo de criação de um site Web, para evitar problemas 
relacionados com tamanhos demasiados de arquivos, deve ser 
considerado, preferencialmente, o uso da resolução das telas 
dos computadores pessoais, que vão de

(A) 54 a 60 dpi.

(B) 72 a 96 dpi.

(C) 640 a 480 dpi.

(D) 1 200 a 2 400 dpi.

(E) 2 400 a 9 600 dpi.

22. Considere o seguinte trecho de um diagrama entidade-
relacionamento, relativo a um banco de dados relacional.

Os atributos que representam um atributo chave e um atributo 
multivalorado são, respectivamente,

(A) CPF e Idade.

(B) CPF e Título.

(C) ID e Título.

(D) Idade e ID.

(E) Nome e Idade.

23. Uma chave candidata de uma tabela deve possuir a proprie-
dade da unicidade, que significa que

(A) nenhum atributo da tabela pode conter valores nulos.

(B) a chave candidata da tabela é composta por apenas um 
atributo.

(C) a tabela contém apenas valores do tipo numérico, não 
comportando valores literais.

(D) o número de atributos não-chave da tabela deve ser menor 
ou igual ao número de atributos chave.

(E) duas tuplas distintas da tabela não contêm valores idên-
ticos para o conjunto dos atributos da chave candidata.
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Considere o trecho de programa a seguir, elaborado na linguagem 
HTML e JavaScript, para responder às questões de números 24 a 26.

<html><body><script>
b = 1
for (i = 0; i < 3; i++)
{
 a = i+1
}
switch (a) {
  case 0:
  alert(“Zero”)
  break
  case 1:
  alert(“Um”)
  break
  case 2:
  alert(“Dois”)
  break
  case 3:
  if (b == 1)
  {
   alert(“Três”)
  }
  else
  {
   alert(“Erro”)
  }
  break
  default:
  alert(“Nenhum”)
}
</script>
<h1>Programa de Teste</h1>
<b>A</b><br>
<i>B</i><br>
<u>C</u><br>
</body></html>

24. Com base no programa apresentado, quando executado, 
surgirá inicialmente na tela, uma janela com a mensagem

(A) “2” e um botão de confirmação “OK”.

(B) “3” e um botão de confirmação “OK”.

(C) “Dois” e um botão de confirmação “OK”.

(D) “Três” e um botão de confirmação “OK”.

(E) “Erro”.

25. Analise as afirmações a respeito do programa apresentado:

 I. caso a segunda linha seja alterada para b = 2, a janela que 
aparecerá na tela será igual à que apareceria antes da alteração;

 II. c a s o  a  t e r c e i r a  l i n h a  s e j a  a l t e r a d a  p a r a 
for (i = 0; i < 5; i++), o programa indicará um erro de 
execução, pois não existirá um comando case para tratar 
o novo valor de a;

 III. c a s o  a  t e r c e i r a  l i n h a  s e j a  a l t e r a d a  p a r a  
for (i = 0; i < 3; i = i + 1), nenhuma alteração no com-
portamento do programa ocorrerá.

Sobre as afirmações, pode-se dizer que está correto o contido em

(A) I, apenas.

(B) II, apenas.

(C) III, apenas.

(D) I e II, apenas.

(E) I, II e III.

26. Analise as afirmações sobre o programa:
 I. caso h1 seja substituído por h5, a primeira linha de texto 

que será escrita na tela possuirá caracteres de tamanho 
maior do que teria com h1;

 II. após o cabeçalho, na tela será exibido:
  A
  B
  C
 III. a tag <br> é equivalente à tag <p>, podendo ser substi-

tuída por ela.

Sobre as afirmações, pode-se dizer que está correto o contido em

(A) I, apenas.

(B) II, apenas.

(C) I e II, apenas.

(D) II e III, apenas.

(E) I, II e III.

27. Por definição, DHTML é

(A) um gerenciador de Banco de Dados.

(B) um padrão de modelagem de dados para sistemas web.

(C) uma combinação entre HTML, Javascript e CSS.

(D) uma interface de desenvolvimento web.

(E) uma linguagem orientada a objetos.

28. Na linguagem de marcação XML, quando se deseja que o seu 
conteúdo não seja analisado pelo parser XML, utiliza-se

(A) um DTD.

(B) o caractere %.

(C) a tag <noparser>.

(D) uma seção CDATA.

(E) a marcação <!-- avoid -->.
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29. Em um arquivo XML, o programador pode escolher os nomes 
dos elementos, o que pode gerar conflitos entre diferentes ar-
quivos fontes. O exemplo dado abaixo apresenta um conflito 
que pode ocorrer com a tag <table>.
<table>
<name>Mesa de café africana</name>
<width>80</width>
<length>120</length>

</table>

Para solucionar o conflito no exemplo, deve-se

(A) incluir um DTD.

(B) inserir uma seção PCDATA.

(C) adicionar uma tag de definição do bloco principal, como 
por exemplo, <%@Definition:table/@%>.

(D) alterar todas as tags de marcação e seus elementos para 
o padrão W3C <#[ . . . ]#>.

(E) usar um prefixo na tag de abertura e seus elementos, 
como por exemplo <h:table>.

30. Quando há a necessidade de se finalizar completamente uma 
sessão, utilizando-se a linguagem de programação ASP, deve-
se utilizar

(A) a função Finish(session).

(B) o atributo Session do método Object.Close( ).

(C) o método Session.Abandon.

(D) o método Session_destroy.

(E) o objeto CloseSession.

31. Considere o seguinte código, escrito na linguagem de progra-
mação ASP.

<%

Dim var

var = Request.TotalBytes

%>

Pode-se concluir que, na variável var, será armazenada a 
quantidade de bytes

(A) da página corrente.

(B) transferidos do servidor para o cliente.

(C) de um arquivo referenciado no formulário.

(D) enviados pelo cliente no corpo do objeto Request.

(E) utilizados por toda a aplicação, em tempo de execução.

32. Na linguagem ASP, é sabido que a propriedade ASPCode, do 
objeto ASPError, traz o código do erro gerado pelo IIS. Para 
se obter uma curta descrição a respeito do erro, utiliza-se a 
propriedade

(A) ErrorInfo.

(B) Description.

(C) ASPSource.

(D) ASPDescription.

(E) ASPCodeInformation.

33. Considere o seguinte código, escrito na linguagem de progra-
mação PHP.

<?
$var = “item1#item2#item3#item4#item5”;
$var1 = explode(“#”,$var);
$var2 = implode(“@@”,$var1);
echo $var2;
?>

Ao ser executado, esse código resultará na saída

(A) Array

(B) Sintax Error

(C) item1

(D) item5

(E) item1@@item2@@item3@@item4@@item5

34. Na manipulação de arquivos, utilizando a linguagem de 
programação PHP, para verificar se o arquivo corrente é um 
arquivo e não um diretório, utiliza-se a função

(A) is_file.

(B) notdir.

(C) file_info.

(D) file_exists.

(E) directory.

35. No VBScript, quando há a necessidade de forçar a declaração 
explícita de todas as variáveis, usando Dim, Private, Public 
ou ReDim, utiliza-se a declaração

(A) Explicit Vars.

(B) Force Declaration.

(C) FDEC.

(D) Option Var.

(E) Option Explicit.

36. Um dos blocos funcionais presentes em sistemas gerencia-
dores de bancos de dados relacionais é o processador ou 
compilador DDL, cuja função principal é

(A) analisar as definições de dados em formato fonte e 
convertê-las para o formato objeto apropriado.

(B) gerenciar o controle de concorrência dos usuários no 
banco de dados.

(C) gerenciar o controle da distribuição dos dados para ban-
cos de dados distribuídos.

(D) impor restrições de integridade e segurança no acesso ao 
banco de dados.

(E) realizar o backup dos dados mais recentes do banco de 
dados.
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37. O dicionário de dados de sistemas gerenciadores de bancos 
de dados contém dados sobre os dados, que também são 
chamados de

(A) pós-dados.

(B) metadados.

(C) dados adaptativos.

(D) dados parametrizados.

(E) dados perpendiculares.

38. No sistema operacional Windows XP, quando é efetuada 
uma cópia de um texto em um programa, por meio das teclas 

 (pressionadas simultaneamente), a informação 
copiada é armazenada  na área  do 
Windows, podendo ser aproveitada em outros programas.

As palavras que completam, correta e respectivamente, as 
lacunas do texto são:

(A) Ctrl e C ... permanentemente ... de Transferência

(B) Ctrl e C ... provisoriamente ... de Trabalho

(C) Ctrl e C ... provisoriamente ... de Transferência

(D) Ctrl e V ... provisoriamente ... de Trabalho

(E) Ctrl e V ... permanentemente ... de Trabalho

39. O Windows Explorer do Windows XP é um

(A) gerenciador de arquivos e pastas.

(B) navegador por meio do qual pode-se acessar páginas da 
Internet.

(C) recurso de apoio ao usuário, por meio do qual pode-se 
obter orientação para a utilização de qualquer recurso.

(D) recurso que permite que discos sejam avaliados, detec-
tando e corrigindo os erros encontrados.

(E) um utilitário que permite a adição ou remoção de com-
ponentes e recursos do sistema operacional.

40. Analise as afirmações sobre a Barra de Tarefas do Windows 
XP:
 I. janelas abertas são representadas por botões nessa barra;
 II. janelas que estejam minimizadas ou ocultas não são 

representadas nessa barra;
 III. o número máximo de janelas abertas que podem ser re-

presentadas por botões nessa barra é 8.

Sobre as afirmações, pode-se dizer que está correto o contido 
em

(A) I, apenas.

(B) II, apenas.

(C) I e II, apenas.

(D) II e III, apenas.

(E) I, II e III.

41. Analise as afirmações associadas ao recurso Ferramentas do 
Sistema do Windows XP:
 I. a opção Tarefas Agendadas permite agendar programas 

que podem ser executados regularmente;
 II. nessa versão do Windows, a Restauração de Sistema foi 

retirada do conjunto desses recursos;
 III. os recursos Scandisk, Desfragmentador de Disco e Lim-

peza de Disco fazem parte dessas ferramentas.

Sobre as afirmações, pode-se dizer que está correto o contido em

(A) I, apenas.

(B) II, apenas.

(C) I e II, apenas.

(D) I e III, apenas.

(E) I, II e III.

42. No Adobe InDesign, a tecla de atalho que faz referência à 
ferramenta de Seleção é a tecla

(A) C.

(B) F.

(C) V.

(D) Ins.

(E) Ctrl.

43. No Adobe Photoshop CS2, para calcular distâncias e ângulos 
na imagem, utiliza-se a ferramenta

(A) Angle and Distance.

(B) Measure Tool.

(C) Move Point Tool.

(D) Samplers Tool.

(E) Smoodge Tool.

44. No Adobe Photoshop CS2, uma possível criação de layers se 
dá por meio do procedimento de selecionar, copiar e colar, 
sobre a imagem. Porém, existe uma restrição: não é possível 
criar um novo layer quando a imagem está no

(A) formato EPS.

(B) formato TIF.

(C) modo canal de 16 bits.

(D) modo cores indexadas.

(E) modo escalas de cinza.

45. Ao se desenhar, utilizando o Adobe Illustrator, as linhas 
resultantes são denominadas paths, nas quais existem dois 
tipos de nós (anchor points), que são:

(A) angle points e rounded points.

(B) corner points e smoth points.

(C) edge points e bridge points.

(D) inner points e dodge points.

(E) square points e circle points.
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46. Ao se trabalhar com o Adobe Dreamweaver em rede com 
arquivos compartilhados, um eficiente método de marcar os 
arquivos protegidos contra alteração, evitando problemas com 
perda de dados, é por meio da opção

(A) Markup files no menu Site.

(B) Lock updated files no menu View.

(C) Check updated files no menu File.

(D) Mark to update no menu Commands.

(E) Enable file check in and check out no Site Definitions.

47. Na codificação de páginas web, por meio do Adobe
Dreamweaver, a opção que possibilita ocultar trechos de 
códigos selecionados é a

(A) collapse.

(B) expand.

(C) hidden.

(D) invisible.

(E) smoth code.

48. No Adobe Flash, o método de interpolação por forma (shape) 
somente é possível quando se utiliza(m)

(A) um objeto do tipo Clip de Filme (Movie Clip) e outro do 
tipo Gráfico (Graphic).

(B) um objeto do tipo Forma (Shape) e outro do tipo Botão 
(Button).

(C) um objeto do tipo SWF e outro do tipo FLA.

(D) dois objetos do tipo Forma (Shape).

(E) dois objetos do tipo Gráfico (Graphic).

49. No Adobe Fireworks, uma funcionalidade muito importante 
na criação/edição de imagens e textos corresponde aos Styles. 
Para se abrir a janela Styles segue-se o seguinte caminho:

(A) Menu Edit > Effects > Styles.

(B) Menu File > Import > Styles.

(C) Menu New > Assets > Styles.

(D) Menu View > Styles.

(E) Menu Window > Styles.

50. No Adobe Fireworks, pode-se adicionar um ou mais filtros 
nos objetos selecionados. Uma propriedade dos filtros é que

(A) podem ser ativados ou desativados em seu uso.

(B) pode-se alterar a ordem de precedência de exibição dos 
filtros.

(C) não podem ser removidos, uma vez que são inseridos.

(D) não se podem alterar os filtros existentes.

(E) só podem ser inseridos em objetos vetoriais.







